Power Query Case Study #2:
Learning Objective: Extract->Transform->Load Delimited Text Files

Sample File Location:  ..\SampleData\SampleTxt\FORM 26AS.txt

Step: #1 Open Power BI->Click Get Data-> Text/CSV

a C > | BB lenerencar [A] ]
= 4 - gomesmEma -

Add data to your report

Once loaded, your data will appear in the Data pane.

5 o] O &
Import data from Excel Import data from SQL Server Paste data into a blank table Try a sample dataset

Get data from another source —

Step: #2 Navigate to the sample files folder and select the ‘Form26AS.txt’

| Open X
« v > SampleData > SampleTxt v 0 £ Search SampleTxt
Organize ~ New folder = @ 0
- Status Date modified Type
M/ FORM 26AS.txt (@P 18-05-2023 15:47 TXT File
I}ype: TXT File 17-02-2022 16:36 TXT File
Size: 2.36 KB

Date modified: 18-05-2023 15:47
Availability status: Available when online
Activity: Shared

File name: [FORM 26AS.txt ™ ‘ Text Files (*.txt;*.csv;*.prn) N




Step: #3 Select Transform Data option in the Extract window

FORM 26AS.txt

File Origin

I - |,

Columnl

(02g

>

AForm 26ASA

File Creation DateAPermanent Account Number (PAN)A...

15-02-2022AAADCT6551BAACTIVEA2021-2022/2022-20...

APART A - Details of Tax Deducted at SourceA

Sr. No.AName of DeductorATAN of DeductorAAAAATotal...
1APIEM HOTELS LIMITED - UNIT HOTEL TAJ VIEW AGRA...
ASr. No.ASectionATransaction DateAStatus of BookingA...

A1A194CA06-Oct-2021AFA25-Jan-2022/A-A36000.00A72...

A2A194CA01-Aug-2021AFA22-0ct-2021A-A36000.00A72...
A37194CA10-May-2021AFA26-Jul-2021A-A36000.00A72...

2ACYGNET INFOTECH PRIVATE LIMITEDAAHMC01115CA...
ASr. No.ASectionATransaction DateAStatus of Booking?...
A1A194CA19-Nov-2021AFA29-Jan-2022A-A55437.00A11...
A2A194CA21-Jul-2021AFA04-Nov-2021A-A28500.00A570...
A3A194CA11-May-2021AFA27-]ul-2021A-A51570.00/10...

3ACRI LIMITEDAAHMC01161GAAMAA36000.004720.004...

© The data in the preview has been truncated due to size limits.

Extract Table Using Examples

Cancel

TransforK'l Data
e

Step: #4 Power Query Editor window will be opened, and it should be like the one below:

{Lines. FronBinary (File.Contants(“C \ \Power8ICourse\Al1apey PlaTXT\FORM 2685, txt"))H) s
] 4 PROPERTIES
Name

All Properties

3 File Creation Date*Pecma
4 APPLIED STEPS.
Source

10.00~27

oKing*ReRArks ARount Paid / Credited{Rs:) Tax Daducted(Rs.) TOS Depoaited (Rs.)

Booking*Remarks"Ancunt Paid / Credit .)*Tax Daducted(R=.) “TDS Dapos 2.1

“Amount baid / Cre

Paid / Credited(Rs.)"Tax DaductediRs.)*T0S Daposited (Bs.)

1 COLUMN, 33 ROWS  Cohumn profling based on top 1000 roms

PREVIEW DOWNLOADED AT 2213



Step: #5 We must remove the top 2 rows. Go to Home->Remove Rows

' = | Untitied - Power Query Editor

Home Transform Add Column View Tools Help
=X — il = Properties B ;Y EeE 5| Data Type: Text = [P Merge Queries ~ = Text Analytics
| ] A EE = pass
OT e e L= & [ Advanced Editor N Al  Use First Row as Headers = T Append Queries ~ €@ Vision
Close&  New Recent Enter Datasource  Manage  Refresh o x Choose  Remove  Keep Remood split  Group ; o
Apply~  Source~ Sources~ Data settings  Parameters~  Preview~ L Manage Columns ~ Columns ~  Rgysa. Rows~ Column~ By -2 ReplaceValues Combine Files A Aaure Machine Learning
Close New Query Data Sources  Parameters Query Manage Columns Refudh Rows  Sort Transform Combine Al Insights
Queries [1] < fx = Table.FromColumns({Ljfles.FromBinary(File.Contents("C:\Users\srath\OneDrive\PowerBICourse\Allapey\Sampl¢

|[Dromss =

1 ~Form 26AS"

Step: #6 Select Remove Top Rows

@ Remove Top Rows

@ Remove Bottom Rows

|28
[mmm)

I Remove Alternate Rows

B>E Remove Duplicates

E‘x Remove Blank Rows
X

|" Remove Errors

Step: #7 Enter number 2 in the textbox and click Ok

Remove Top Rows

Specify how many rows to remove from the top.

Number of rows

& 1

C% Cancel

Step: #8 Make a Reference Query: Right Click on ‘FORM 26AS’ query and select Reference

series [1 < Jo | = Table.skip(source,2) s

4 PROPERTIES
Name

4 APPLIED STEPS.

Source
 Removed Top Rows.




Step: #9 Double Click on the name of the second query and rename to Deductee

Untitied - Power Query Editor

=

Home | Tansform  AddColmn  View  Toos  Help

=% e N Properties - -

-t Lo ] 3 Advanced Editor was Headers *

Close&  New Recent Enter Datasource  Manage s E i

Apply~ Source- Sources® Data  settings  Parameters~ - [ Manage oS " Cobtn B

Close New Query Data Sources  Parameters Query Manage Calumns Reduce Rows  Sort Transform Combine
Queries [2] < 3 = $"FORM 26AS"

7] FORM 26AS

sl A°c Columnl
1

|D FORM 26A5 (2} File Creation Date”Permanent Account Number (PAN..

No.”Name of Deductor”TAN of Deductor”***~Tot..

1"PIEM HOTELS LIMITED - UNIT HOTEL TAJ VIEW AGRA.
asx.

2 | 15-02-20227AADCT6551B*ACTIVE~2021-202242022-2023..
3

4 |"PART A - Details of Tax Deducted at Source”

5 |Sr. N

6

7

N

Section“Transaction Date“Status of Book..

Transform AddColumn  View Tools Help
=X 2 fr— & [=] | [ Properties ‘ L 8 I o DataType:Text~
- e e & [ Advanced Editor X £l! 7] Use First Row as Headers ~
Close & New Recent  Enter Data source Manage Refresh . Choose  Remove! Split Group
Apply~  Source Sources~ Data settings  Parameters®  Preview > =3 Manage Columns = Columns Column= By sz Replace Values
Close New Query Data Sources  Parameters Query Manage Columns Sort Transform
Queries [2] < fx = #"FORM 26AS"
] FORM 26AS
B —0x
] Deductee 1 File Creation Date“Permanent Account Number (PAN..
2 15-02-20227AADCT6551B*ACTIVE~2021-202272022-2023...
3
4 ~PART A - Details of Tax Deducted at Source”
5 |Sr.

No.”Name of Deductor”TAN of Deductor”””*~~Tot..

Step: #11 Select Keep Top Rows

Kegp Top Rows

Keep Bottom Rows

Keep Range of Rows
Keep Duplicates

Keep Errors

Step: #12 Enter number 2 in the textbox and click Ok

Keep Top Rows

Specify how many rows to keep.

Number of rows

2

Allnsights
[ Merge Queries ¥ = Text Analytics
Append Queries ~ @ Vision

Combine Files

A Azure Machine Learning

Combine Allnsights

Cancel



Step: #13 Click Split Column option in the Home Menu

Setting:

I FORM 2645 4 PROPERTIES
Name.

1 Deductee

4 APPLIED STEPS.

Source
| > Kapt First Rows

Step: #14 Select By Delimiter

By Delimiter

By Number of IC%aracters
By Positions

By Lowercase to Uppercase
By Uppercase to Lowercase
By Digit to Non-Digit

By Non-Digit to Digit

Step: #15 Confirm that the delimiter is “A” and click Ok.

Split Column by Delimiter

Specify the delimiter used to split the text column.

Select or enter delimiter

--Custom-- v ]

A

Split at
O Left-most delimiter
O Right-most delimiter

@ Each occurrence of the delimiter

> Advanced options

Quote Character

[ ] Split using special characters

Cancel




Step: #16 Click Transform Menu and Transpose Tool Button

1| = | Untitled - Power Query Editor

Table

Queries [2]

Step: #17 Deductee Query should look like this

4 = | Untitled - Power Query Editor
Home Transform Add Column

Permanent Account Number (PAN)
Current Status of PAN
Financial Year

Name of Assessee
Address Line 1

Address

1
2

3

4

5 Assessment Year
6

7

8 Line
9

Address

Line

2
Line 3
0 Address 4
11 Address Line 5
12 |Statecode

13 Pin Code

Home Jransform Add Column View Tools Help
% o8 Transpot} Data Type: Text ¥ 15, Replace Values ~ *-D)J Unpivot Columns ~ "v"‘
& Reverse Rows I Detect Data Type Fill = E(l_'_ﬁ Move ~ r
Group Use First R o - - I 0 . Spli
By s Hesdersls 2 Count Rows Rename 3, Pivot Column Convert to List Colurr

Any Column

Jx

= Table.TransformCo

View Tools Help
pmm 5 Transpose DataType:Any~ L, Replace Values ~ & Unpivot Columns ~ . { MetgeColumns  XO  EES 2 v  [— P
i |E222 — —_ [ ABC, > Bm 10 y
[E Reverse Rows Detect Data Type (] Fill I Move - | 155 Extract -
Group Use First Row e - . Split  Format ., . Statistics Standard Scientific . Date Duration  RunR Run Python
By asHeaders~ {H CountRows ™l Rename T pivotColumn || Convertto List Colomn~> =~ ‘nrParse 5 5 = Inform % A 5 saipt. saipt
Table Any Column Text Column Number Column Date & Time Column Scripts
Queries [2] < K = Table.Transpose(#"Changed Type")
] FORM 26AS sl 755 Column1 2% Column2 -
—_—_—
" Deductee File Creation Date 15-02-2022

AADCT6551B
ACTIVE
2021-2022
2022-2023

TATA CLIMATE TECHNOLOGIES PRIV..
OLOGIES PVT LTD

NO 180 9TH CROSS 5TH MAIN

INDIRA NAGAR
BANGALORE
KARNATAKA
560038

Step: #18 Again Right Click on original base query “FORM 26AS” and Select Reference

1 = | Untitled - Power Query Editor
Home | Tansorm | AddCouma  View  Tools  Help

ospose DwaType T~ Rl ke = G UrghvorCoires < {1+ g

Reverse Rows T Detect Data Type [§] Fill~ & Move >
D e ] CountRoms i Rename FitCoumn [ Comvertiotist oot o
Tbe Any Cokinn ®
Queries [2] < fx = Table.Skip(Source,2)

Con¥. ¥c Column1

ile Creation Date”Permanent Accou
5-02-2022°AADCT6551B ACTIVE 2021~

| ZFORM 2( =
Deducte » 1,
=1 Renome
V| Enable load
/| indude in report refresh

PART A - Details of Tax Deducted |

35 Oupicate

® Rofeonce r. No."Name of Deductor“TAN of De:
/’ Mave To Group * |"PIEM HOTELS LIMITED - UNIT HOTEL
Sr. No.”Section”Transaction Date"!

Move Down
Ciusts P, 1°194C~06-0ct-2021F~25-Jan-2022"

27194C*01-Aug-2021"F"22-0ct-2021*
& Advanced Editor

34194C*10-May-2021*F~26-Jul-2021*

Properties.

=

12 2°CYGNET INFOTECH PRIVATE LIMITED
13 | "Sr. No.”Section’Transaction Date®
14 | ~1194C*19-Nov-2021°F~29-Jan-2022
15 | ~27194CA21-Jul-2021°FA04-Nov-2021~
16 |737194C711-May-2021°F 27-Jul-2021*




Step: #19 Double Click on the new query and rename the same as “Deductor”

1| = | Untitled - Power Query Editor

Home Transform Add Column View Tools Help

— 2o Transpose Data Type: Text * 1,2 Replace Values ~ 5= Unpivot Columns ~ i H)ﬁ,,-:‘f'“. Ivv] Merge Columns

e o i SN 5
Reverse Rows Detect Data Type || Fill Aove ¥ ! 155 Extract ~ ka
Split  Format

Statistics Stand:

Group Use First Row abe

By e Hendorer 3 Count Rows =] Rename Pivot Column || Convert to List colutrin" s 57 Parse ™ = o
Table Any Column Text Column
Queries [3] < fx = #"FORM 26AS"

= rorm s =

T De
Deducio I

File Creation Date”Permanent Account Number (PAN..

15-02 2022°AADET6551BCACTIVE 2021 2022220222023
A“PART A - Details of Tax Deducted at Source”

1~PIEM HOTELS LIMITED - UNIT HOTEL TAJ VIEW AGRA.

1
2
3
4
5 ' Sr. No.”Name of Deductor”TAN of Deductor*""""Tot..
6
7 |~8r. No.~Section~Transaction Date~Status of Book.
8

SBACE 6Ol = AL S B 2 5= dan= 2000 2 s S60 0l 0 0 0A 250

Step: #20 We have to remove the top 4 rows. Go to Home->Remove Rows

§ = Untitled - Power Query Editor

Home  Transform Add Column  View Tools  Help
=% 2 T p— =] i Properties B Y s 4| Data Type: Text ~ [P Merge Queries ~ = Text Analytics
| ] ~ T : =3 %

- Lo ] = &7 [ Advanced Editor . X N &l Use First Row as Headers = % Append Queries = €@ Vision
Close&  New Recent Enter Daasource  Manage  Refresh o = Choose  Remove  Keep Remoed split  Group , R ot

Apply=  Source~ Sources~ Data  settings  Parameters~  Preview = L Manage Columns ~ Columas ~ o Rows ™ Column~ By 2 Replace Values b Al SRR KMo eacikng

Close New Query Data Sources  Parameters Query Manage Columns Reflid Rows  sort Transform Combine Allnsights

Queries [1] < Jx = Table.FromColumns({Ljfes.FromBinary(File.Contents("C:\Users\srath\OneDrive\PowerBICourse\Allapey\Sample

| = romass o

1 “Form 26AS"

Step: #21 Select Remove Top Rows

¥ Rerove Top Rows

&as Remove Bottom Rows
[

. Remove Alternate Rows

an Remove Duplicates

Remove Blank Rows

X
|'>’( Remove Errors

Step: #22 Enter number 4 in the textbox and click Ok

Remove Top Rows

Specify how many rows to remove from the top.

er of rows

4\

Cancel



Step: #23 Click Split Column option in the Home Menu

Setting:

I FORM 2645 4 PROPERTIES
Name.

1 Deductee

4 APPLIED STEPS.

Source
| > Kapt First Rows

Step: #24 Select By Delimiter

By Delimiter

By Number of IC%aracters
By Positions

By Lowercase to Uppercase
By Uppercase to Lowercase
By Digit to Non-Digit

By Non-Digit to Digit

Step: #25 Confirm that the delimiter is “A” and click Ok.

Split Column by Delimiter

Specify the delimiter used to split the text column.

Select or enter delimiter

--Custom-- v ]

A

Split at
O Left-most delimiter
O Right-most delimiter

@ Each occurrence of the delimiter

> Advanced options

Quote Character

[ ] Split using special characters

Cancel




Step: #26 Deductor Query should be like this

o | Query Setting:
1 FORM 26AS. ~ M Columnl.3 - M Columnid = M Columnls - M Columal ~ M Columal.? ~ M Columal.s 4 PROPERTIES
™ Deductee 1 - ¥ eductor Anount Fa  Name
1 Deductor 2 2 PIEN HOTELS LIMITED - UNIT HOTE e
3 . n action Tzansaction tate sooking ate of Booking Fonatk Al Properties
4 a o -
~ = 4 APPLIED STEPS.
¢ o 1oy SrurTETY = Source
> = : : : : Ramoved Top Rows
Spit Colum by Delimiter
a2 L Y
s : . king king ~ | chenged Type
10 s
" 4 1 4 1
2 ] sac s
it ’
3 L w01
15 o. ansa a . £ Booking omar n
i v 1 3
7 1 u e :
w4 HTAS SHARMACEUTT 1 3
19 B . 2 ate v = Booking ena
2 it b . ” 35744
2 i = = . King ring Rmarts A
2 o4 7 1
x P ‘ 1
6 s '
z ] " 1 1 .
< >
11 COLUMNS, 27 ROWS. Column profing based on op 1000 rows PREVIEW DOWNLOADED AT 2223

Step: #27 Go to Transform Menu and click Use First Row as Headers to promote the headers

1| = | Untitled - Power Query Editor

Add Column View Tools Help

E Transpose Data Type: Any ™ 15, Replace Values ~ ";:‘ Unpivot Columns ~ ¥ = : [++] Merge Columns XO 102 _J Trigonometry ~
e iy < | ABL| 5 7 .
NZ Reverse Rows 7 Detect Data Type || Fill ¥ & Move ~ L 155 Extract ~ £ 18 Rounding ~
Group{ Use First Row |} = oo . Split  Format _,_ Statistics Standard Scientific — .
By 41 Count Rows =]i Rename 9L, Pivot Column Convert to List Column'> = S Parse ¥ = - , ;.J Information ~

Any Column Text Column Number Column

Queries [3] < fx Table.TransformColumnTypes (#"Split Column by Delimiter",{{"Colu

] FORM 26AS . ABc Columnl.l ['7 ABc Columni.2 i} ABc Columnl.3
D Deductee 1 |Sr. No. Name of Deductor TAN of Deduct
[ Deductor 2 |t PIEM HOTELS LIMITED - UNIT HOTEL T.. AGRP10610F

3 St ING- Section

4 1 194C

5 2 194c

Step: #28 Go to Add Column Menu and click Conditional Column

Untitled - Power Query Editor
Home  TransfQ ~ AddColumn  View  Tools  Help

=251 £, Conditional Cglumn| ., (1| Merge Columns = 2 | Trigonometry * —
| ! [adc Y Bm 100 57 = ©
index Column 145 eraa ~ 3 Rounding *
¥ i Format 5 ics Standard Scientific R Jate  Time Duration Tt Vision Azure Machine
| Duplicate Column - ShParse % E [ information ~ - - * Analytics Learning
From Text From Number From Date & Time Al Insights
Queries (3] < K = Table.TransformColumnTypes(#"Promoted Headers",{{"sr. No.", Int64.Type}, {"N

T FORM 26AS B ABc Name of Deductor ~ | A TAN of Deductor - | ABc

1 Deductee 1 1 PIEM HOTELS LIMITED - UNIT HOTEL T.. AGRP10610F

™ Deductor 2 null sr. No. Section Tra
3 null 1 194c 06-
4 null 2 194cC 01
5 null 3 194C 10
6 null null null
7 2|CYGNET INFOTECH PRIVATE LIMITED AHMCO01115C
8 null Sr. No. Section Tra
9 null 1 194C 19-




Step: #29 Enter the condition as in the screenshot below:

a. Enter New Column Name as DeductorName

b. If Sr.No. equals null output is null (note the null in lowercase)

c. Inthe else clause click on the dropdown and select ‘Select Column’

Add Conditional Column

Add a conditional column that is computed from the other columns or values.

New column name

DeductorName

Column Name

b | If Sr. No. ad

Add Clause

Operator Value O

ABC
equals + | 123 || null

Else ®
C AEC

55  Enter a value

1 Select ﬁolumn

Parameter

Step: #30 In the combobox select ‘Name of Deductor’

Sr. No.
Name of Deduct
TAN of Deductor

1
2

3

Total Amount Paid / Credited(Rs.)
Total Tax Deducted(Rs.)

Total TDS Deposited(Rs.)

Column11

Output @

ABC
Then 1237

null

Step: #31 Ensure that the Add Conditional Column window looks like this and Click Ok.

Add Conditional Column

Add a conditional column that is computed from the other columns or values.

New column name

DeductorName

Column Name Operator Value O
" S No. - | | equals - | 45 | o
Add Clause

Else O

M - || Name of Deductor -

Then

Output @

ABC .,
123

null

Cancel



Step: #32 Again Go to Add Column Menu and click Conditional Column

1| s  Untitled - Power Query Editor
Home  TransfdQ ~ AddColumn  View  Tooks  Help

o | Conditional Clumn -+]-] 2 Trigonometry ¥ — |
2 = S [wéc] BEm 107 = ©
index Column "™ 14 Bract +°5 Rounding *
Column From Cugfl Invoke Cust z Format atistics tandard Scientific % ot e Tet  Vision Azure Machine
arieb Duplicate Column 2 v 5 = & information Aralytics DR
From Text From Number From Date & Time Al insights

Queries 3] < f

= Table.TransformColumnTypes(#"Promoted Headers",{{"sr. No.", Int64.Type}, {"N

7] FORM 26AS 58 123 Sr. No. [ ~ | A% Name of Deductor ~ | A% TAN of Deductor L3
AR,

™ Deductee

1 1| PIEM HOTELS LIMITED - UNIT HOTEL T.. AGRP10610F

] Deductor 2 aull sr. No. section Tra
3 null 1 194¢C
4 null 2 194cC 01
5 null 3 194C
6 null null null
7 NET INFOTECH PRIVATE LIMITED AHMCO01115C
8 null s No. Section Tra
9 null 1 194C 19-

Step: #33 Enter the condition as in the screenshot below and click Ok:

a. Enter New Column Name as TAN
If Sr.No. equals null output is null (note the null in lowercase)

c. Inthe else clause click on the dropdown and select ‘Select Column’ and select TAN of
Deductor

Add Conditional Column

Add a conditional column that is computed from the other columns or values.

New column name
a TAN

Column Name Operator Value ® Output ®
b v

Add Clause

ABC ABC
Sr. No. - equals ~| (123 7 || null Then 123 7 | null

Else ®
D ¥ [ TAN of Deductor -




Step: #34 Scroll to right end and select both DeductorName and TAN columns; right click and select
Fill->Down as below

else [TAN of Deductor]) v
) By Copy f ?gg DeductorName fgg TAN n
mmmmm ' Remove Columns Lo

R PIEM HOTELS LIMITED - UNIT HOTEL T.. AGRP10610F

i Add Column From Examples... i noll null

Remove Duplicates null null

Remove Errors
null null

2 Replace Values...

_j Fill > Dow& null null
/ Change'lype J o null null

Transform >

CYGNET INFOTECH PRIVATE LIMITED AHMCO1115C
Merge Columns
=, Group By.. i null null
% Unpivot Columns null null
Unpivot Other Columns
, null null
Unpivot Only Selected Columns
Mova . null null
null null null null
CRI LIMITED AHMCO01161G
null null null
null null
null null null null

Step: #35 DeductorName and TAN should be filled like this

[+] {‘gg DeductorName : fgg TAN :

=
PIEM HOTELS LIMITED - UNIT HOTEL T.. AGRP10610F
null PIEM HOTELS LIMITED - UNIT HOTEL T.. AGRP10610F
PIEM HOTELS LIMITED - UNIT HOTEL T.. AGRP10610F
PIEM HOTELS LIMITED - UNIT HOTEL T.. AGRP10610F
PIEM HOTELS LIMITED - UNIT HOTEL T.. AGRP10610F
null PIEM HOTELS LIMITED - UNIT HOTEL T.. AGRP10610F
CYGNET INFOTECH PRIVATE LIMITED AHMCO01115C
null CYGNET INFOTECH PRIVATE LIMITED AHMCO01115C
CYGNET INFOTECH PRIVATE LIMITED AHMCO01115C
CYGNET INFOTE@h PRIVATE LIMITED AHMCO01115C
CYGNET INFOTECH PRIVATE LIMITED AHMCO01115C
null CYGNET INFOTECH PRIVATE LIMITED AHMCO01115C
CRI LIMITED AHMCO01161G
null CRI LIMITED AHMCO1161G

CRI LIMITED AHMCO01161G



Step: #36 Scroll to the left and click filter button on Sr.No. column and select like this to eliminate
outer table data

1| = | Untitled - Power Query Editor

Home Transform Add Column View Tools Help

- : : F! conditional Column Y ol Merge Columns XO -+ 2 Trigonomet:
: : & £ Index Column ~ T 85S Extract v o &k 328 Rounding ~

Column From Custom Invoke Custom . Format . Statistics Standard Scientific — N
Examples¥ Column  Function [ Duplicate Column o 3 Parse . - - Information
General From Text From Number
Queries [3] < fr = Table.FillDown(#"Added Conditi
7 FORM 26AS AB- Name of Deductor
]| 4] Sort Ascending PIEM HOTELS LIMITED
| (1 %| Sort Descending Sl M
a5
2
3
Remove Empty
Number Filters » | CYGNET INFOTECH PRIV

Sr. No.
Segrcﬁ/ :
&felect All)
A 2
Bl . 3
=X I’\?

(] 1
L2 CRI LIMITED
[]
:‘ 3 Sr. No.
L4 v -
[]5
Cancel INTAS PHARMACEUTICAI
1o rreemeet| ST . NO.
19 null|l

20 null




Step: #37 Right click on first column Sr.No. and Remove that column since it is also from outer table
data

1| = | Untitled - Power Query Editor

Home Transform Add Column View Tools Help

m m [A [ Conditional Column Ad/(; [++] Merge Columns +[—] 102 A Trigonomet
! : X B index Column ~ T 15S Extract v . &Ik 328 Rounding *
Column From Custom Invoke Custom . Format Statistics Standard Scientific .
Examples~ Column  Function [ Duplicate Column = S Parse ¥ = - - Informatior
General From Text From Number

Queries [3] < fx = Table.SelectRows(#"Filled Dol

™ FORM 26AS i @@ Copy of Deductar
R
] Deductee SRS

7 Deductor

Remove Other Columns
Duplicate Column
7 Add Column From Examples...

Remove Duplicates

HoOwWwW NN =

Remove Errors

Step: #38 Rename all the columns with the headers from the first row manually like this:

1| = | Untitled - Power Query Editor
Home Transform Add Column View Tools Help

lur y . i try~  [° o
Format Statistics entif Date Time
General From Text From Number From Date & Time Allnsights
Queries [3] < fx = Table.Ren\njeColumns(#"Removed ColumMps”,{{"Name of Deductor”, "SrNo."}, {"TAN of Deductor", "Section"}})
] FORM 26AS M. A% srNo. ~ | M Section ~ sactipnDate BA’( A v| M 2 i
—

] Deductee ﬁ sr. No. Section Transaction Date Status of Booking Date of Booking Re
| ™ Deductor 2 1 194C 06-0ct-2021 F -Jan-2022 -

3 |2 194c 01-Rug-2021 F -

a Tanm 10 maw 2n21 =

Step: #39 See how the columns are renamed from the formula bar

fr | = Table.RenameColumns(#"Removed Columns",{{"Name of Deductor", “SrNo."}, {"TAN of Deductor", "Section"}, {"*, "TransactionDate"}, {"_1", "BookingStatus"}, {"_2", “BookingDate"},
{"_3", "Remarks"}, {"Total Amount Paid / Credited(Rs.)", “"Amount Paid / Credited(Rs.)"}, {"Total Tax Deducted(Rs.)", "Tax Deducted(Rs.)"}, {"Total TDS Deposited(Rs.)", "TDS
Depusi(ea(RS.)")))'

I

Step: #40 Right Click Column 11 (which is empty) and Remove Column

\ o
Rs.) { Remove ABC

- Ded
e Remoue thr s e e A R
Rs.) Duplicate Column null PIEM }
" Add Column From Bxamples, e
Remove Duplicates
Remove Errors sl
Change Type . PIEM |
| Thansform i1 null PIEM }
42 Replace Values...
Rauj o DEacEisues null CYGNE1
Replace Enors.
Split Column CYGHE]
= Group By. CYGNE1
i CYGNE1
8- Unpivot Columns
Unpivot Other Columns 1 null CYGNE]
Rs.) Unpivot Only Selected Columns nuill CRI L1
=] Rename. e
Move
p— 1 null|CRI L1
Rs.) Add as New Query null| INTAS
400.00 INTAS

null null null INTAS



Step: #41 Select the filter button of SrNo. Column (first column) and deselect SrNo. and null

1| = | Untitled - Power Query Editor
Home Transform Add Column View Tools Help

y s EE‘lConditional Column . /‘ [++] Merge Columns X0 - e
1 # \A8C| 10

2 ' Trigonometry ~

ué Index Column ~ 123 Bxtract ™ 3.0 Rounding ~
Column From Custom Invoke Custom i ' Format Statistics Standard Scientific . ) Date  Time Duration Text Visior
Examples™  Column EUriction [ Duplicate Column & 57 Parse = - - i+ Information 2 < - Analytics
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Step: #42 Click on the ABC button of SrNo. column
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Step: #43 Select Whole Number
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Step: #44 Likewise for the columns — TransactionDate and BookingDate format as Date

1le.TransformColumnTypes (#"Filter Inte
bl ABc €12 Decimal Number - ABc
= $ Fixed decimal number e

1 194¢ 3 06-0ct-2021 F
123 Whole Number

2/194(9% Ppercentage 01-Aug-2021 F

3 194(E) Date/Time 10-May-2021 F

1] Lais 19-Nov-2021 F
@ Time

2|194(@® Date/Time/Timezone 21-Jul-—2021 F

3/194(¢® Duration 11-May-2021 F
AB,

e 30-Sep-2021 F
%, True/False

1 194« 15-Dec-2021 F
El Binary

1|194  Uuing Locale. 30-Sep-2021 F

2|194cC 11-Jun-2021 F

3|/194cC 18-May-2021 F

4.194C 18-May-2021 F



E12 Decimal Number

Fixed decimal number

7 123 Whole Number %

% Percentage

B Date/Time
[ Date
®© Time

D\ - .
&3 Date/Time/Timezone

& Duration

ABc Text

True/False

%
[ Binary

Using Locale...

AB- Remarks

Al A5 Amount Paid / Credited(Rs.)

04-08-2021
04-08-2021
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Step: #46 No column should be left as ABC123 (which is unknown) Make the text columns as ABC
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PIEM HOTELS LIMITED - UNIT HOTEL T..

PIEM HOTELS LIMITED - UNIT HOTEL T..

PIEM HOTELS LIMITED - UNIT HOTEL T..

CYGNET INFOTECH PRIVATE LIMITED

CYGNET INFOTECH PRIVATE LIMITED

CRI LIMITED

INTAS PHARMACEUTICALS LIMITED

NARAYANI HOTELS AND RESORTS LIMITED

NARAYANT HOTELS AND RESORTS LIMITED

A
A
A
A
A
CYGNET INFOTECH PRIVATE LIMITED A
A
A
A
A
A

NARAYANI HOTELS AND RESORTS LIMITED

Step: #47 Since we don’t require the base query FORM 26AS for analysis, disable the loading by right
clicking and click on Enable Load
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Step: #48 Now Go to File Menu and Select Close and Apply
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Step: #49 Power Query Editor will be closed and in Power Bl Main window you can see that

Deductee and Deductor tables are loaded
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Cancel



Step: #50 You can see in the right side of Power Bl Main window that both the tables are loaded
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Build visuals with your data

Select or drag fields from the Data pane onto the report canvas.

Please save the Power Bl file for further analysis and use.



